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 Chapter 1: Introduction 
 

The Zapex FLASH-DVD Kit uses some parts found in the Gemini 
DVD Pro System, but only consists of a FLASH-DVD software 
program, a Zapex ZP-230/330 encoder PCI  board and support 
software, and a DVD play back video card This product is a one-button 
operation system that can convert various video/audio sources to a 
DVD data format that can be written to a DVD disc.  

 
 
 

 
 

Chapter 2.  System Installation
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Chapter 3: Setting Up the FLASH DVD System 
 
3.1 Starting the Flash DVD Program. 
Once the system installation has been completed power up the PC and 
double click on the Flash DVD icon to start the Flash DVD program. 
The warning dialog box and Flash DVD Welcome window shown in 
Figure 3.0 will appear. If I Agree is selected in Figure 3.0 then the 
window in Figure 3.1 will appear. 

 
Figure 3.0 
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Figure 3.1 
 

 
3.2 Starting A New Project 
The window shown in Figure 3.1 presents the option of starting a new 
project or producing a copy of a previous one. Make a choice and select 
Next to go to display Figure 3.2. Select New Recording Session. 
 
3.3 Selecting a DVD Region Code. 
The window shown in Figure 3.2 provides the option of selecting a 
DVD region code for the DVD-R disc. Up to 6 different region codes 
can be specified or an ALL selection can be made to cover all regions. 
Select a region code and then click on next to display the window show 
in Figure 3.3. 
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Figure 3.2 

 
3.4 Defining a New Directory. 
The window shown in Figure 3.3 allows you to specify a directory on 
the hard drive to store your DVD files. Each directory that you create 
will require at least 8GB. If there is not 8GB of space left, a warning 
message will appear. After a directory has been specified click next to 
move to the next window shown in Figure 3.4. 
 
Note: The default directory D:\User\VIDEO_TS\ is a working 
directory and the files in this directory will be erased at the start of 
each new project. If you want to keep the project files for future 
use such as making copies the select another directory such as job1.  
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Figure 3.3 
 

 
3.5 Initializing the Encoder 
The window shown in Figure 3.4 shows that the system is being 
initialized and it will take about 30 seconds for this process to be 
completed. When the initialization process is completed, the window 
shown in Figure 3.5 will appear.  
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Figure 3.4 

 
 

3.6 Setting Encoding Parameters. 
Select the Options header in Figure 3.5 and the window shown in 
Figure 3.6 will be displayed. This window offers two choices:  

  --Properties 
 --Information 
 

Select and click on the Properties tab to display the window shown in 
Figure 3.7. There are two choices: 

 --Encoder Parameter 
  --DVD Parameter  
 

Select and click on the Encoder Parameter tab to display the window 
shown in Figure 3.7. 
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Figure 3.5 
 

 
 

Figure 3.6 
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Figure 3.7 
  

 
 
 

 3.6.1 Video and Audio Settings. 
Select NTSC setting and PCM or Dolby Digital Audio settings in 
Figure 3.7. 

   
3.6.2  Project Encoding Time. 
Set an Encoding Time equal to the run time of your source data and 
select OK to return to the main window shown in Figure 3.5.  
 
Note: In order to ensure optimum quality the encoding time must 
be set for each new project. Two hours is the maximum run time 
for a 4.7GB disc and a warning message is given if you exceed the 
disc capacity.  

  
 3.7 Setting the DVD-R Recording Parameters. 

Select and click on the Options tab in the main window shown in  
Figure 3.5, then the Properties tab and finally the DVD Parameter tab 
shown in to display the window shown in Figure 3.8.  
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Figure 3.8 
 

 
 
 

3.7.1 Logo Header Option. 
The option of having a Logo Header is enabled by checking the Add 
Logo box in Figure 3.8. There can be up to 10 canned logos. To select 
the logo you want click on the Logo tab in Figure 3.8 to display the 
window shown in Figure 3.9. 
 
A new logo can be added by clicking on the Add Logo File tab in 
Figure 3.9 to open the window shown in Figure 3.10. Insert the CD 
with the new logo and open the Flash-DVD folder to show Figure 3.11. 
Open the Logo Files folder in Figure 3.11 and open the Logo sample 
you want in Figure 3.12. Select the Vts_01_vob file click on open and 
the logo is automatically loaded and ready for use.  
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               Figure 3.9 
 

 
 
 
                     Figure 3.10 
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        Figure 3.11 
 

 
 
 
         Figure 3.12 
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         Figure 3.13 
 

        
 
 
3.7.2 Region Code. 
Set the DVD-R  region code. There can be up to 6 region codes or 
select All to cover all regions. 

 
3.7.3 Play Mode. 
Set the Play Mode to either Single play or Loop. 

 
  3.7.4 DVD-R Capacity. 

  Set the capacity of the DVD-R media to either 3.9GB or 4.7GB. 
 
  Note: Check the DVD-R label to get the correct capacity number.  

 
3.7.5 Selecting DVD-R Recording Mode. 
The modes of operation that can be selected are shown in Figure 3.8 
and discussed below. 
 

• Preview Before Writing: 
  This mode allows you to preview your job before committing to 

writing it to a DVD-R. 
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• Write 
If this mode is selected the DVD-R disc will be written automatically 
with no interruption for preview. 
 
• Test 

This mode will allow you to test the image file, DVD-R writer, and 
cable connections. During the Test process all steps are completed 
except the actual writing of the DVD-R.  
 
• Verify 

This mode will check the accuracy of the written DVD-R. This 
process will occur immediately and automatically after the DVD disc 
is written. 
 

3.7.6 Selecting Number of Copies. 
  The number of multiple copies can be selected at the beginning of 

the project by entering the copy count in Figure 3.8. The number of 
copies can also be selected after the Image File is created using the 
Copy mode discussed in section 4.7. 

 
  Note: The total number of DVD-R discs burned and number of 

Image Files created are displayed on the main window as shown 
in Figure 3.5. 

 
When all the DVD-R recording parameters have been set select OK 
to display the main menu shown in Figure 3.5. 
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Chapter 4:  Writing a DVD-R Disc. 
 

4.1  Starting the Encoding Process. 
Once the parameters have been set for a new job the process is started 
by clicking the New Job button shown on the main window shown in 
Figure 3.5. After the New Job button has been selected a window will 
appear to alert the operator to check settings for critical Encoding and 
DVD parameters. The New Job button will change to a yellow Start 
button as shown in Figure 4.1 when the system is ready. To start the 
encoding process select the yellow start button and encoding will start 
as shown in Figure 4.2. 

         Figure 4.1 
      

   
 
 
4.2 Stopping the Encoding Process. 
The real time encoding process can be stopped at any time by 
selecting the stop button shown in Figure 4.2. Once the encoding 
process is stopped the image file will be generated for the encoded 
data. 
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        Figure 4.2 

 

 
 

 
4.3  Creating the DVD IFO File. 
Once the encoding process has been completed or stopped a Video 
Object Block (VOB) file is created and stored in the work directory 
located on the hard drive. The next step in the process is creating an 
IFO file. This process will start automatically as shown in Figure 4.3 
and the Stop button will be inactive during this process. Generation of 
the IFO file cannot be stopped.  
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        Figure 4.3 
 

 
 
 

4.4  Creating the DVD Image (UDF) File. 
Once the IFO file is created the process to generate the Image File starts 
automatically. During this process the Stop button is active (see Figure 
4.4) and the process can be stopped at any time. The unfinished Image 
File cannot be written to a DVD-R disc. 
 
4.5  Previewing the DVD Image File. 
If the at the beginning of the project the Preview Only mode was 
selected (Section 3.7.4), the process will stop here and the Start button 
will change to a Record button as shown in Figure 4.5. The procedure 
for previewing the image file is given in Chapter 5. 
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        Figure 4.4 

 
        
        Figure 4.5 
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4.6  Writing the DVD-R. 
  4.6.1 Writing the Image File After Preview. 

If the Preview Only mode has been selected, the image can be 
previewed and either stored on the hard drive or written 
immediately on a DVD-R after the preview by selecting the 
Record shown in Figure 4.5. Once the Record button is selected a 
blue writing button will appear to indicate the writing process is 
underway. This is illustrated in Figure 4.6. 
 
      Figure 4.6 
 

 
 

 
4.6.2 Writing the Image File Without Preview. 
If the Write mode was selected at the beginning of the project the 
Image file will automatically be written to the DVD-R. In this 
mode the process from encoding to writing the disc is one 
continuous process. When the DVD-R writing process is 
completed, the window shown in Figure 4.7 will be displayed. 
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        Figure 4.7 
 

 
 

4.7 Making Copies of the Image File. 
The copy option allows the user to choose the ability to make multiple 
copies of a completed project without spending time creating the VOB, 
IFO, and Image files. Copies can be made anytime.  
 
  4.7.1 Selecting Number of Copies 

Click on the Copy tab shown in Figure 4.8 to display the window 
shown in Figure 4.9 and enter the number of copies.  
 

4.7.2 Enter Copy Job File. 
 After setting the number of copies, enter the job file that you 

want to copy in Figure 4.9. 
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        Figure 4.8 
  

 
 
        Figure 4.9 
 

 
 

4.7.3 Writing Multiple Copies. 
Once the number of copies and file to be copied are set in 
Figure 4.9 click OK and the main window shown in Figure 4.10 
will appear. Select the Copy button to start writing the DVD-R. 
The writing process will be indicated as shown in Figure 4.11.  
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     Figure 4.10 
 

 
 

      Figure 4.11 
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Chapter 5: Preview of Image File. 
 

A preview of the image before it is written to a DVD-R disc can be 
viewed on the PC monitor using a Hollywood Plus decoder card and 
REALmagic software.  

 
5.1 Starting the REALmagic Playback Program. 
To start the playback process click on the DVD Station icon located on 
the PC desktop and the window shown in Figure 5.1 will be displayed. 

 
Figure 5.1 
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5.2 Playback of Image Written on the DVD-R disc. 
The next step is to click on the Options Dialog folder icon just to the 
right of the clock. This will open up the window shown in Figure 5.2. 
Select the Virtual Drive that was specified in Section 6.3 from the Play 
List shown in Figure 5.2 and click OK to start the playback process.  

 
Figure 5.2 
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Chapter 6: File Management 
 

6.1 File List. 
Select the File tab in the main Flash DVD window to pull down four 
items: Work Directory, Virtual Drive, Copy, and Exit. as shown in 
Figure 6.1 

Figure 6.1 
 

 
  

6.2  Work Directory 
 The Work Directory is where all project files are stored. These are the 
VOB (.vob), DVD IFO (.ifo), and DVD Image (.dvi)  files. The default 
work directory is \User\VIDEO_TS. Note: The files stored in this 
directory are temporary and are erased when a new project is 
started. 
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The project files can be saved if the Work Directory is changed to a 
directory different than the default directory. This can be done by 
clicking the Work Directory tab shown in Figure 6.1 to display the 
window in Figure 6.2  A new work directory can be selected or created 
here. Note: The window shown in Figure 6.2 can also be opened by 
selecting the Change Directory button in Figure 3.3. 

          
         Figure 6.2 
 

       
 
 

6.3 The Virtual Drive 
Select the Virtual Drive tab shown in Figure 6.1 to open the Virtual 
Drive window shown in Figure 6.3. Define a virtual drive using a letter 
that is not included in the first line of the window. Defining a virtual 
drive is required in order to playback the finished project on a video 
monitor. Playback is discussed in chapter 5. Note the virtual drive can 
be defined after a new project has been completed or it can be 
defined for an old project at anytime.  
 
6.4  Exit Flash DVD Program. 
Click on the Exit tab shown in Figure  6.1 to quit the Flash DVD 
application. 
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Figure 6.3 

               
6.5  Information on VOB File. 

 Select the information tab shown in Figure 6.4 to open the window 
shown in Figure 6.5  which gives specific information about the VOB 
file.  

                   Figure 6.4 
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6.6 Help and About Window. 
 6.6.1 Help Topics 

The help topics that are available can be displayed by clicking 
the Help tab in the main menu. These topics are shown in 
Figure 6.6. 

Figure 6.5 

 
 
  6.6.2 About Flash DVD 

The information on the Flash DVD program can be found by 
clicking on the About tab to display the window shown in 
Figure 6.7. 
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       Figure 6.6 
 

 
 

       Figure 6.7 

 


